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Introduction 

This document provides guidelines for installing and using the IDT F0442 Dual Matched Broadband RF Digital Variable Gain Amplifier 
Evaluation System (EVS). The F0442 EVS includes a custom software application that is specific to this product family and controls the device 
on the evaluation board via the supplied USB Interface board. This document describes how to obtain and install the software, identify the 
components of the Evaluation System, and make connections to the evaluation board. It also describes the steps and interface to control and 
use the F0442 device using the custom software application.  

For the purposes of this document, the Evaluation System is referred to as “EVS”, and the Evaluation Software is referred to as “GUI”; an 
acronym for graphical user interface.  

Evaluation System Contents 

The Evaluation System consists of the following: 

 F0442 evaluation board

 USB interface board

 USB-A to USB-B micro cable

 Custom interconnect ribbon cable

Minimum Requirements for Evaluation System 

Computer (or Laptop) 

 Microsoft Windows Operating System – Windows 7 or higher

 Standard powered USB port on the computer or laptop for connection to the USB Interface Board

 IDT USB Interface Board (FTDI FT-2232H device, supplied with Evaluation System)

 User account with administrator privileges for installing software

Power Supply 

 Regulated 5.0V power supply capable of sourcing 0.5 Ampere to the evaluation board connection

 Power supply cable and adapters to make connection using SMA connector

 Typical power supply cable assembly consists of (user provided, not included in the Evaluation System):

 Banana Male to BNC-F: Pomona # 1269

 BNC-M to BNC-M cable 36 Inch: Pomona # 2249-C-36

 BNC-F to SMA-M adapter (DC Bias only): Pomona # 4290

Instrumentation 

 Vector Network Analyzer and calibration standards (recommended)

 Signal generator

 Spectrum analyzer

 Coaxial cables



F0442 Evaluation System User Guide 

© 2019 Integrated Device Technology, Inc. 5 November 4, 2019 

Evaluation Software 

Downloading the Software 

If a USB thumb drive is not supplied as part of the Evaluation System, you can download the F0442 Evaluation Software installer package from 
the IDT website at http://www.idt.com. Use the search feature of the website to locate the software by searching for the part number. You can 
also locate the software in the customer portal of the IDT web support system. For access, contact IDT sales or field application engineering.  

Installing the Software 

1. Execute the application setup.exe by double clicking on the icon.

2. Follow the installer prompts as indicated in Figure 1 to Figure 7.

Figure 1. Windows User Access Control 

The Windows security alert may show on your system. Verify the 
application has been signed by Integrated Device Technology, Inc. 
before proceeding.  

Figure 2. Installation Extracting Files 

The installation application will extract the installation files to a temporary 
directory before installation can proceed. 

http://www.idt.com/
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Figure 3. Installation Confirmation 

The installation is now ready to begin. Click on the “Next” button to 
continue the installation. 

Figure 4. License Terms and Conditions 

Please review the License Terms and Conditions of the Evaluation 
Software to proceed with the installation. To proceed, click the radio 
button before clicking the “Next” button.  

Figure 5. Installation Location 

Confirm the desired location of the installation files. The default location 
is acceptable for most users. Proceed by clicking the “Next” button. 

Figure 6. Installation Confirmation 

Review the installation summary and finalize the installation by clicking 
the “Install” button. 
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Figure 7. Installation Complete 

The dialog confirms that installation has been completed successfully. 

Installing the USB Interface Board Driver 

If the PC is connected to the internet, simply plug in the USB-A to USB-B Micro cable to the USB Interface board. Once done, this initiates the 
automatic driver installation through a Windows Update. After connecting the cable to the USB port on the PC, wait for notification that the driver 
installation has completed successfully (for an example of the notification, see Figure 8). If the Windows Update was successful, skip the manual 
driver installation.  

Figure 8. USB Interface Board Windows Update Progress 

If Windows Update or an internet connection are not available, the F0442 software installer places the FTDI driver installer on the local disk for 
offline installation. Click the start button, then navigate to the recently added program “USB SPI Driver Installer” (see Figure 9). 

Figure 9. Offline Driver Installer via Start Menu Recently Added Group 

If the recently added application is not available on the start menu, navigate to the IDT programs folder and launch the USB SPI Driver Installer 
(see Figure 10).  
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Figure 10. Start Menu IDT Program Group 

After selecting the USB SPI Driver Installer, the application to install the USB Interface drivers will launch. 

Figure 11. Windows User Access Control 

The Windows security alert may show on your system. Verify the 
application has been signed by Future Technology Devices 
International, Ltd. before proceeding. 

Figure 12. Installation Extract Files Confirmation 

The installation application extracts the installation files to a 
temporary directory before installation can proceed. Click “Extract” 
to proceed.  

Figure 13. Installation Extract Files 

The installation application displays the progress of the file 
extraction. 

Figure 14. Installation Confirmation 

The installation is now ready to begin. Click the “Next” button to 
continue the installation.  
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Figure 15. License Agreement 

Please review the License Agreement of the FTDI USB Driver 
Software to proceed with the installation. To proceed, click the radio 
button before clicking the “Next” button.  

Figure 16. Installation Progress 

The dialog confirms that installation is underway. This may take 
several minutes to complete depending on the speed of the 
computer.  

Figure 17. Installation Complete 

This dialog confirms the installation completed successfully. 
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Controlling the F0442 

The F0442 supports two types of serial programming, I3C and SPI. I3C programming is not enabled on the current release of the evaluation 
software. The F0442 uses a standard serial communication protocol for control of the 31dB digital step attenuator (DSA), the fixed 6dB 
attenuator, amplifier bypass, and KGain controls on each channel. Control of the DSA1 (6dB) and DSA3 (18dB) attenuators are achieved using 
external pins. Standby mode for each path is selected using two external pins. Two external address pins on the device set the serial address 
to allow multiple devices on the same SPI bus to share a single chip select line. A single external pin selects I3C or SPI programming.  

SPI Device Control 

The F0442 in SPI mode is controlled with a single 16-bit command word (two bytes). The word consists of the channel address (0-1), path 
select (channel A or B), KGain state (on / off), DSA2 setting (0-31), DSA2 6dB attenuator enable, and the amplifier bypass state (on / off). Each 
byte is transmitted with the most significant bit (MSB) first. For bit location and specific programming plus timing information, see the “SPI 
Programming” section in the F0442 Datasheet.  

Standby Mode Parallel Control 

Each F0442 channel can be placed into a standby mode using dedicated Channel STBY pins (STBY_A, STBY_B); for more information, see 
the truth table in Table 1. Note that when a channel is disabled, the serial register for that channel will hold the last enabled DSA state. For 
additional programming and timing information, see the “STBY Mode Programming” section in the F0442 Datasheet.  

Table 1. STBY Logic Truth Table 

Channel 
STBY_X Pin 

Logic Channel Power State 

A 
0 Channel A Standby (SPI still active) 

1 Channel A Power On 

B 
0 Channel B Standby (SPI still active) 

1 Channel B Power On 
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DSA1 Attenuator Parallel Control 

Each F0442 channel contains a 6dB attenuator prior to amplifier 1 and can be controlled using the dedicated DSA1 pins (DSA1_A, DSA1_B); 
for information, see the truth table in Table 2. For additional programming and timing information, see the “Parallel Programming of DSA1 and 
DSA3 Using External Control Pins” section in the F0442 Datasheet.  

Table 2. DSA1 Truth Table 

Channel 
DSA1_X Pin 

Logic Attenuation State 

A 
0 Channel A DSA1 0dB 

1 Channel A DSA1 6dB 

B 
0 Channel B DSA1 0dB 

1 Channel B DSA1 6dB 

DSA3 Attenuator Parallel Control 

Each F0442 channel contains an 18dB attenuator after amplifier 2 and can be controlled using the dedicated DSA3 pins (DSA3_A, DSA3_B); 
for information, see the truth table in Table 3. For additional programming and timing information, see the “Parallel Programming of DSA1 and 
DSA3 Using External Control Pins” section in the F0442 Datasheet.  

Table 3. DSA3 Truth Table 

Channel 
DSA3_X Pin 
Logic Value Attenuation State 

A 

0 Channel A DSA3 0dB 

1 Channel A DSA3 6dB 

2 Channel A DSA3 12dB 

3 Channel A DSA3 18dB 

B 

0 Channel B DSA3 0dB 

1 Channel B DSA3 6dB 

2 Channel B DSA3 12dB 

3 Channel B DSA3 18dB 
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Cable Connections 

1. Connect the USB Interface Board to the PC with the USB-A to USB-B Mini cable.

2. Connect the USB Interface Board to the F0442 Evaluation Board with the supplied ribbon cable (see Figure 18).

3. Connect the power supply to VCC using J14 SMA connector.

Figure 18. USB Interface Board to F0442 Evaluation Board Connections 

Table 4 defines the connections required between the USB Interface Board and the F0442 Evaluation Board. This information is provided to 
describe the supplied adapter cable and the signal positions within the connectors.  

Table 4. USB Interface Board Connections to F0442 Evaluation Board 

USB Interface Board 
Connection 

F0442 Evaluation 
Board Connection 

Signal Name Wire Color 

J5-1 J21-21 DSA3_B_1 Brown 

J5-2 J21-19 DSA3_B_0 Red 

J5-3 J21-17 DSA3_A_1 Orange 

J5-4 J21-15 DSA3_A_0 Yellow 

J5-5 J21-13 DSA1_B Green 

J5-6 J21-11 DSA1_A Blue 

J5-9 J21-16 GND White 

J5-10 J21-14 GND Black 

J5-11 J21-12 GND Brown 

J5-12 J21-7 CSB Red 

J5-13 J21-10 GND Orange 

J5-15 J21-8 GND Green 

J5-16 J21-5 SCLK/SCL Blue 

J5-17 J21-6 GND Violet 

J5-18 J21-3 SDATA/SDA Grey 

J5-19 J21-4 GND White 

J5-20 J21-2 GND Black 

J5-7 J23-2 STBY_B Violet 

J5-8 J22-2 STBY_A Grey 

J5-14 J6-2 SPI_I3C_SEL Yellow 
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Evaluation Software User Interface 

Figure 19 shows the available controls on the main panel of the F0442 Evaluation Software in Control View. 

Figure 19. F0442 Evaluation Software – Control View 

Figure 20 shows the controls available to the user in register view. The software front panel conveys information about the current state of the 
F0442 and the USB Interface Board. The controls enable the user to evaluate all functions of the device.  

Figure 20. F0442 Evaluation Software – Register View 
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USB Interface Board Status 

Figure 21 shows the different states that are possible for the status of the USB Interface Board. This status information bar is located at the 
bottom of the main window, and is updated whenever the connection to the USB Interface Board changes. The messages indicate “IDT USB 
Interface Board connected”, and “Please connect IDT USB Interface board.” When “Searching for connected USB interface boards. Please 
wait…” is shown, the software is enumerating the boards on the FTDI bus and waiting for the board to complete the driver configuration. 

Figure 21. USB Interface Board Connection Status 

USB Interface Board Configuration 

Figure 22 shows the electronic serial number of the USB Interface Board that is in use by the Evaluation Software. In the case that multiple 
Interface Boards are detected by the software, the user can select the appropriate board to communicate with the IDT device. When multiple 
devices are detected, inserting one board at a time allows the user to identify the target board. Some systems may take up to 15 seconds to 
identify the board and serial number connected to the system.  

The communication protocol selection defaults to SPI. I3C is not supported in this version of software. 

The SPI Chip Address can also be selected from the drop-down menu. This address must match the address set by the jumpers J7 (ID_0) and 
J8 (ID_1) on the Evaluation Board (for jumper configuration, see Table 5). Pin 1 for J7 and J8 are indicated by the square pad on the bottom of 
the PCB.  

Figure 22. USB Interface Board Configuration 

Table 5. Device ID Jumper Configuration Table 

Device ID 

J7 Jumper 
Position 

ID_0 

J8 Jumper 
Position 

ID_1 Logic Value 

0 2-3 2-3 0 

1 1-3 2-3 1 

2 2-3 1-3 2 

3 1-3 1-3 3 
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Device Information 

Figure 23 shows basic information about the F0442 to aid the user with configuring the evaluation board. Information such as frequency 
information, gain, gain control range, gain step size, impedance, and supply voltage are supplied. 

Figure 23. Device Information 

Device Programming Views 

Figure 24 shows the tab selections possible in the Evaluation Software. Clicking the “Control View” tab shows a window with the basic 
settings for each channel: DSA0 Attenuation setting (dB), DSA1 Attenuation setting (dB), AMP1 bypass, DSA2 Attenuation setting (dB), DSA3 
Attenuation setting (dB), Standby settings, and KGain enable. Clicking the “Register View” tab shows a window with multiple controls for each 
channel controlling the attenuator settings, amplifier bypass, and the standby GPIO bits. The byte value for each is also shown. All controls 
are bound together – changing any control on either tab page updates the control on the other page.  

Figure 24. Device Programming Views 

Attenuation Control 

Figure 25 shows the attenuation controls per channel. The value can be changed by clicking the control with the mouse and selecting the 
desired value with the drop-down menu. Once the control has been selected with the mouse and is highlighted, the user can change the 
attenuation setting by using the keyboard up arrow and down arrow keys.  

Figure 25. Attenuation Controls 
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Amplifier Bypass Control 

Figure 26 shows the controls for the Amplifier 1 bypass per channel. The value can be changed by clicking the control with the mouse and 
selecting the desired value with the drop-down menu. After the control has been selected with the mouse and is highlighted, the user can toggle 
the setting by using the keyboard up arrow and down arrow keys.  

Figure 26. Amplifier Bypass Controls 

Standby Control 

Figure 27 shows the standby controls for each channel. Each channel can be powered on or placed into standby by clicking the control with the 
mouse and selecting the desired state from the drop-down menu. After the control has been selected with the mouse and is highlighted, the 
user can change the state setting by using the keyboard up arrow and down arrow keys.  

Figure 27. Standby Controls 

KGain Enable Control 

Figure 28 shows the KGain enable controls per channel. The value can be changed by clicking the control with the mouse and selecting the 
desired value with the drop-down menu. Once the control has been selected with the mouse and is highlighted, the user can toggle the setting 
by using the keyboard up arrow and down arrow keys.  

Figure 28. KGain Enable Controls 
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Update All Button 

Figure 29 shows the “update all” button. Clicking this button will program the serial words to the device and set the states of the standby GPIO 
values. This is useful if the F0442 has been reset through the power supply and the user wants to program all the states, attenuation values, 
and settings for both channels shown on the main software window with a single click.  

Figure 29. Update All Button 

Graphical User Interface Menu Functions 

File Menu 

Figure 30 shows the available functions under the File menu. The only choice is the Exit menu item. 

Figure 30. Exit Menu Item 

Exit Menu Item 

The Exit drop-menu item allows the user to gracefully exit the application. Simply use the mouse to select the “File” menu, then select “Exit” 
from the drop-down menu that appears. Figure 31 shows the confirmation dialog box that confirms the choice to exit the application. Selecting 
“Yes” will exit the application; selecting “No” will return the user to the application. 

Figure 31. Exit Confirmation Dialog Box 

Help Menu 

Figure 32 shows the available functions under the Help menu. The choices for the Help menu item are About, Install IO Drivers, and EVB 
Connections. 

Figure 32. Help Menu 
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About Menu Item 

The About menu item allows the user to see the version information contained in the application. Simply use the mouse to select the “Help” 
menu, then select “About” from the drop-down menu that appears. Figure 33 shows the message box that contains the version information. 
Select “OK” to close this message box.  

Figure 33. About Message Box 

Install IO Drivers Menu Item 

The Install IO Drivers menu item allows the user to see an abbreviated set of instructions to manually install the USB Interface Board drivers. 
Simply use the mouse to select the “Help” menu, then select “Install IO Drivers” from the drop-down menu that appears. Figure 34 shows the 
dialog box that contains the brief instructions. Select “Close” to close this dialog box.  

Figure 34. Install IO Drivers Menu Item 
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EVB Connections Menu Item 

The EVB Connections menu item allows the user to see an abbreviated set of instructions to connect the EVB to the USB Interface Board and 
the power supply. Simply use the mouse to select the “Help” menu, then select “EVB Connections” from the drop-down menu that appears. 
Figure 35 shows the dialog box that contains the brief instructions. Select “Close” to close this dialog box. 

Figure 35. EVB Connections Menu Item 
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Revision History 

Revision Date Description of Change 

November 4, 2019 Initial release. 

Corporate Headquarters 
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www.IDT.com  

Sales 
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Tech Support 

www.IDT.com/go/support 

DISCLAIMER Integrated Device Technology, Inc. (IDT) and its affiliated companies (herein referred to as “IDT”) reserve  the right to modify the products and/or specifications described herein at any time, 
without notice, at IDT's sole discretion. Performance specifications and operati ng parameters of the described products are determined in an independent state and are not guaranteed to perform the same 
way when installed in customer products. The information contained herein is provided without representation or warranty of any kind, whether express or implied, including, but not limited to, the suitability 
of IDT's products for any particular purpose, an implied warranty of merchantability, or non -infringement of the intellectual property rights of others. This document is presented o nly as a guide and does not 
convey any license under intellectual property rights of IDT or any third parties.  

IDT's products are not intended for use in applications involving extreme environmental conditions or in life support systems  or similar devices where the failure or malfunction of an IDT product can be 
reasonably expected to significantly affect the health or safety of users. Anyone using an IDT product in such a manner does so at their own risk, absent an express, written agreement by IDT.  

Integrated Device Technology, IDT and the IDT logo are trademarks or registered trademarks of IDT and its subsidiaries in the Uni ted States and other countries. Other trademarks used herein are the 
property of IDT or their respective third party owners. For datasheet type definitions and a glossary of common terms, visit www.idt.com/go/glossary. All contents of this document are copyright of Integrated 
Device Technology, Inc. All rights reserved. 
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